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I.  RECLASSIFY AND SWEEP WORDS 
 
A. Overview  

1. What is the purpose of the 
Reclassify and Sweep 
Words function? 

The Reclassify and Sweep Words function lets you update the Word Search 

index for one or more data directories, if needed. 

 

This process updates the list of words that the system uses when you do a 

word search.  The list includes: 

 

• an example of each word used in the database, and 

 

• a reference to every record that contains the word 

 

Note:  Word Search will find only words in your data that have been 

indexed.  Numeric and date fields may not be indexed.  Many 

common words are not indexed, such as articles (the, a, and an) and 

prepositions.  See Section C below for words excluded from word 

search. 

2. How does Reclassify and 
Sweep update the Word 
Search list? 

The Reclassify and Sweep process updates the word search list by: 

 

• adding any new words from new or updated records 

 

• removing any words that have been deleted from records 

 

• placing pointers to new word locations 

 

• removing pointers to records for words that have been deleted 

 

Note: Reclassify and Sweep rebuilds the Word Search index for all records 

in the selected directory.  For large amounts of data, it may take some time 

for the process to finish, depending on the size of your database and the 

speed of your computer.  You may work in other areas of the program while 

Sweep is running. 

3. Do I need special security 
rights to run Reclassify and 
Sweep? 

Yes.  You must have Administrator security rights to use the Reclassify and 

Sweep function.  See Section V of this chapter for information on user 

security. 

B. Running Reclassify and 
Sweep Words 

 

1. When do I need to run the 
Reclassify and Sweep 
function? 

The software automatically maintains the Word Search index for all records.  

As you add or modify records, the program automatically updates the Word 

Search index so that searches will be accurate.   

 

After you Add, Modify, or Copy a record and save it, the data you entered is 

immediately searchable through Quick Search and Advanced Search.  

Likewise, changes you make using the following functions are also 

automatically reclassified and immediately available to searches: 

 

• Spell Check 

• Mass Supplemental Update 

• Modify All Records 
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• Global Search & Replace 

• Quick Entry 

• Import 

• Data Updates (formerly Laptop Copy) 

• Load to Empty Directory 

• Transfer to Another Directory 

 

If a search does not find data that you know is in your database, use 

Reclassify and Sweep Words to update the Word Search index for the 

specific directory. 

2. How do I run Reclassify and 
Sweep Words? 

To run Reclassify and Sweep Words: 

 

• From the Tools menu, choose Reclassify and Sweep Words. 

 

 

 • In the List Pane, select the directory you want to sweep.  In systems with 

many data directories, you can select multiple directories by pressing 

Shift-Up/Down Arrow, Shift-Click or Ctrl-Click.  You can select all 

directories by pressing Ctrl-A. 

 

• Click Reclassify # Selected Directory to start the process on the 

Reclassified Words Information page.  When complete, a message will 

indicate the process is finished. 

 

 

 • Click OK. 
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3. Can I reclassify and sweep 
a specific group of records? 

Reclassifying  a tag set is not yet available in Version 8.  When it becomes 

available in a future update, you will be able to activate a tag set and click 

Reclassify Tag Set on the Tag Set toolbar. 

C. Word Search List  

1. Can I see a list of the words 
in my Word Search list? 

Yes.  You can view the list of words that Word Search uses when you access 

the Advanced Search function. 

 

To access Advanced Search: 

 

• On the button bar, click the Advanced Search button , or 

 

• From the Record menu, select Advanced Search, or 

 

• Press Alt-8 on your keyboard. 

 

Then in the Advanced Search window: 

 

• Press F5 or select Concordance List on the Tools menu. 

 

 

 All the words available for Word Search are on this list.  If the word you are 

searching for is not on the list, Word Search cannot find records that match.  

Run the Reclassify and Sweep Words function if you cannot find words in 

the list that you are sure are in the database. 

2. Is every word that I enter 
kept in my Word Search 
list? 

No.  Reclassify excludes a number of common words (“a”, “an”, “the”, etc.)  

and prepositions from the Word Search list.  

3. How can I view the excluded 
words list? 

You can access the excluded words list from several places: 

 

• Tools menu from any module (select Words to Exclude from Word 

Search) 

 

• Advanced Search window (select Excluded Words from the Tools menu) 

 

• Reclassify and Sweep Words window 
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To view the words excluded from Reclassify and Sweep, click Edit Words to 

Exclude from Word Search. 

 

 

4. How do I add or delete 
words in the excluded words 
list? 

• To add a word to exclude, click New Word.  A new box will open at the 

end of the list.  Enter the new term and press enter. 

 

• To delete an excluded word so that it will be searchable, highlight the 

word in the list and click Delete Selected Word(s). 

 

• You can also modify words in the list.  Highlight the word and click Edit 

Word. 

 

Note:  After you have added, modified or deleted words in the Excluded 

Words list, you must Reclassify and Sweep the directory for Word Search to 

record the changes.  Refer to Section B above. 

5. Can I print the excluded 
word list? 

Yes.  Click Print List at the top left of the Excluded Words list window.  

Then click the printer button in the preview window. 
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II.  BACKUP DATA 
 
A. Overview  

1. Does ANCS+ include a 
backup utility? 

Yes.  ANCS+ includes a Backup Data utility.  However, if your park already 

has a reliable backup system, it is recommended that you continue to use it.  

You must use the Backup Data utility in ANCS+: 

 

• if you do not have a reliable backup system in place 

 

• to perform data backups from within ANCS+ 

 

• to provide a backup of your data for your annual submission to WASO 

and the National Catalog 

 

• to provide data to the NPS Web Catalog (if subscribed) 

 

• to send data to another park or contractor 

2. How does the Backup Data 
utility work? 

The backup options in ANCS+ use the SQL server backup function and 

SharpZip library utility to create compressed copies of select data and system 

files.  Use these compressed copies as your backups.  The Backup Data 

utility has 5 options for users to make data backup copies. 

3. Do I need special security 
rights to use the Backup 
Data utility? 

Yes.  The Backup Data utility is security-protected.  You must have 

Administrator security rights to access this utility.  Refer to Section VI of this 

chapter for information on security. 

4. Why should I back up my 
ANCS+ data? 

Make regular backups of your ANCS+ data to save your information from 

loss.  You also need to make a copy of your data for your annual submissions 

(catalog records, CMR and ACP) to WASO and the National Catalog. 

 ANCS+ gives you the increased convenience of performing and tracking 

your collection documentation and management processes in one central 

location.  Having all your object data and collection management data 

together also increases the importance of keeping that data safe.  You have 

an obligation to keep the government’s records secure.  Spend the time it 

takes to make and store electronic copies of your data. 

 

Your computer and its data are vulnerable in the event of: 

 

• catastrophic natural occurrences such as floods, earthquakes, fires 

 

• power outages or fluctuations 

 

• employee error 

 

• employee sabotage 

 

• theft 

5. How often should I back up 
my ANCS+ data? 

If your park does not have a reliable backup system already, make backup 

copies of your data after long sessions of data entry and editing.  You should 

also back up your data before making major changes like Modify All and 

Global Search and Replace in case a mistake is made during that process. 
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6. Where should I store my 
ANCS+ data backup 
media? 

Store your data in a safe place away from your work area, preferably in 

another building in a locked, fireproof safe.  Make sure that both your 

computer and its backup data are not vulnerable to the same events at the 

same time. 

7. How should I back up my 
ANCS+ data? 

For WASO and National Catalog Submissions: 
Use the Backup Data utility in ANCS+ to create the compressed file that will 

be uploaded to the catalog submission ftp site through the internet.  You may 

also wish to write the backup to a CD or other large storage capacity media. 

 

For your protective data backups: 

Use the most convenient and efficient backup procedures available. 

 

If your park…   Then 
 

has reliable equipment and  continue to use those. 

procedures in place to regularly 

backup ANCS+, 

 

does not have reliable equipment use the Backup Data utility in ANCS+ 

and procedures in place to  and a CD writer or other large capacity 

regularly backup ANCS+,  storage media. 

8. Why must I use the ANCS+ 
Backup Data utility to submit 
my museum records to 
WASO and the National 
Catalog? 

The compressed file format created by ANCS+ allows the data to be loaded 

back into another ANCS+ system (the National Catalog) using a data loading 

function within the program.  This data loading function will only accept 

backup files created by ANCS+. 

B. Using the Data Backup   

1. How do I access the Data 
Backup utility? 

To access the Backup Data utility,  

 

• click on the File menu on the Menu Bar and select Backup Data, or 

 

• press Alt-F and then B on the keyboard. 

 

 

 You will see the Data Backup window: 
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2. What are the available 
backup options? 

The available backup options are: 

 

Backup Name Zip File Name Created 

 Complete System Backup  CompleteSystem-{date}.zip 

 

All databases (data only) AllData-{date}.zip 

 

National Catalog Submission ACP-directory-CatalogSubmission-

{date}.zip 

 

Web Catalog transfer directory-WebCatalogTransfer-

{date}.zip 

 

Selected Directories directory-{date}.zip 

 

Note:  All zip file names include the date in the name.  The options that 

allow you to select directories will also include the directory names chosen in 

the filename (e.g., CR_PARK-NH_PARK-8-21-2006.zip) 

Include Images This option, when checked along with one of the main backup options, will 

include all images associated with the selected directory.  This option is 

automatically included with a Complete System backup and the Web Catalog 

transfer. You may wish to select it for the All databases or Selected 

directories backups.  It is not available with the National Catalog Submission 

backup. 

 

Note:  The backup file name will reflect this option by  including 

“WithImages” in the file name. 

Include files shared with other 
directories 

This option, when checked along with one of the main backup options, will 

also select other directories that have shared data with the directories you 

have chosen to backup.  This shared data might include: 

 

• accession information  

• artist/maker data 

• names and addresses 

• authority table data 
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For example, your main Natural History directory shares the accessions 

information with the Cultural Resources directory.  If you are only backing 

up the Natural History directory, you would not get the accessions 

information unless you selected this option to include the shared data.  This 

option is automatically included in the Complete System backup and the All 

databases backup.  You may select it for the National Catalog Submission or 

Selected Directories backups if desired.  It is not available with the Web 

Catalog transfer option. 

3. What are the steps to run a 
backup? 

The basic steps for running a backup are: 

 

• Select a backup option. 

 

• Select directories if the backup option requires it. 

 

• Select whether to Include Images and/or Include files shared with other 

directories, if available. 

 

• Select the location to save the backup file. 

 

• Optionally select to name the backup file manually. 

 

• Click Start Backup.  

4. Are there options to restore 
my data from a backup? 

Yes.  Use the Load to Empty Directory utility located on the File menu.  See 

Section VI of Chapter 8 for further information on Load to Empty Directory 

5. How will I be able to 
distinguish between my 
backups if they have the 
same name? 

Notice that in each zip file name the date is included in the file name.  This 

provides an instant reference to the date the backup was made and usually a 

unique file name (unless the backup was made on the same date as another). 

C. Complete System Backup  

1. What is the Complete 
System Backup option? 

This option includes the entire program, data and images.  This option 

automatically includes images and all shared data.   

 

Note:  This is the recommended backup option if you are not using a 

commercial product specifically designed to backup computer files to protect 

your entire computer system. 

2. How do I run the Complete 
System backup option? 

To run the Complete System backup: 

 

• In the Backup Data window, select the Complete System backup option. 

 

• Select the location to save the backup file by typing a path in the location 

field or clicking Browse to select a location. 

 

• You also have the option to name the zip file with a different name.  To 

do this, uncheck the “Use default backup zip filename”.  Another field 

will appear below the Default backup zip filename allowing you to enter 

an alternate name.  Note:  It is recommended that you use the default 

backup zip filename so that it is easier to identify the type of backup file 

that is created. 
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• Click Start Backup.   

 

• You will receive a warning message that this may take a long time 

without the option to cancel.  Click Yes to proceed with the backup. 

 

• Once the backup has completed, you will receive a confirmation 

message with the name and location of the zip file.  Click OK. 

 

The resulting zip file will be named:   

CompleteSystem-date.zip 

D. All Databases (data only)  

1. What is the All Databases 
backup option? 

This option includes all databases in all directories.  You have the option to 

include images with this backup by checking Include Images.  It creates a 

backup of the data only for all directories. 

2. How do I run the All 
Databases backup option? 

To run the All Databases backup option: 

 

• In the Backup Data window, select the All Databases (data only) backup 

option. 

 

• Select the location to save the backup file by typing a path in the location 

field or clicking Browse to select a location. 

 

• If you want to include images with your data, check the Include Images 

option. 

 

• You also have the option to name the zip file with a different name.  To 

do this, uncheck the “Use default backup zip filename”.  Another field 

will appear below the Default backup zip filename allowing you to enter 

an alternate name.  Note:  It is recommended that you use the default 

backup zip filename so that it is easier to identify the type of backup file 

that is created. 

 

• Click Start Backup.   

 

• You will receive a warning message that this may take a long time 

without the option to cancel.  Click Yes to proceed with the backup. 

 

• Once the backup has completed, you will receive a confirmation 

message with the name and location of the zip file.  Click OK. 

 

The resulting zip file will be named:   

AllData-date.zip or  

AllData-WithImages-date.zip (if you included images) 

E. National Catalog 
Submission 

 

1. What is the National Catalog 
Submission backup option? 

This option includes selected directories for your park to submit to the 

National Catalog as well as your Automated Checklist (ACP) data.  You 

cannot include images with this backup. 
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2. How do I prepare my 
catalog data for annual 
submission to the National 
Catalog? 

To prepare data for submission to the National Catalog in Harpers Ferry, 

WV, you must create: 

 

• tag sets of the catalog data you are submitting for the fiscal year, and 

 

• a zipped backup file of the directory or directories that contain the tag 

files. 

 

Use the Filter and Tag Set functions to create tag sets of the Cultural 

Resources and Natural History catalog records you are submitting.  You must 

make a separate tag set for each directory.  Name tag sets using the park 

acronym, Cultural Resources (CR) or Natural History (NH) designator, and 

two-digit fiscal year. 

 

Example: GETTCR06 

 GETTNH06 

 

Note:  Make sure to remove draft records from the tag sets.  Activate a filter 

or do a word search within the tag set for all records with an object status of 

Draft Record.  Update these records before submission.  The National 

Catalog does not count or print records with an object status of Draft Record.  

A list of draft records will appear in the report you receive from the National 

Catalog. 

3. What records do I submit to 
the National Catalog? 

Submit the records in your park’s Natural History and Cultural Resources 

directories.  Include the catalog records that you completed or changed (other 

than minor modifications) during the previous fiscal year (October 1 – 

September 30) in tag sets within the directories. 

 

Submit only electronic records.  The National Catalog will print archival 

copies of the records for storage at the National Catalog.  At your request, the 

National Catalog will print blue working copies of the records for the park. 

 

Note:  The databases you submit to the National Catalog will be used to run 

the Collections Management Report (CMR) for your park.  They will also 

include your annual Automated Checklist submission. 

 Make sure that you complete your ACP before creating the backup files for 

the National Catalog Submission.  Refer to Appendix J for information on 

completing your ACP. 

 
4. How do I back up my 

directories for the National 
Catalog Submission? 

 

To back up the directories: 

 

• Choose Backup Data on the File menu. 

 

• In the Backup Data window, select the National Catalog Submission 

option. 

 

• The Management Reports module (for the ACP) will be checked 

automatically.  Select your catalog record directories under Collections 

for your catalog submission.  These will be the directories with your 

park acronym followed by Cultural Resources and Natural History.  

(Check all that apply for your catalog submission). 

 

• Select the location to save the backup file by typing a path in the location 

field or clicking Browse to select a location. 
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 • “Use default backup zip filename” should be checked. 

 

• Click Start Backup. 

 

• You will receive a warning message that this may take a long time 

without the option to cancel.  Click Yes to proceed with the backup. 

 

• Once the backup has completed, you will receive a confirmation 

message with the name and location of the zip file.  Click OK. 

 The resulting zip file will be named: 

 

ACP-Directory-CatalogSubmission-date.zip. 

 

(Directory will be the names of the directories you selected – e.g., 

CR_PARK-NH_PARK.) 

 Parks submitting only natural history records should also include their 

Cultural Resources directory.  This ensures that the National Catalog 

receives all related accession records. 

 
5. When do I submit my 

catalog records to the 
National Catalog? 

 

Submit your catalog records by the national deadline which is currently 

September 15 of the fiscal year. 

6. How do I submit the 
records? 

To submit your records: 

 

• Use Windows Explorer or My Computer to locate your backup zip file 

created in step 4 above.  Highlight the zip file.  Copy the file using Ctrl-

C on the keyboard; or right-click and choose Copy; or choose Copy from 

the Edit menu.  Note:  You will not see anything happen.  The file is 

copied to the Windows clipboard waiting to be pasted. 

 

• Open your Internet browser (such as Internet Explorer).  Type the 

following address:  

 

ftp://204.176.104.69/catalogsubmissions/ 

 

Enter the user name: NCSNPS 

Enter the password: NCSNPS!1 

Note: You may see other park zip files at this site. 

 

• Paste your file using Ctrl-V on the keyboard; or right-click and choose 

Paste; or choose Paste from the Edit menu.  You’ll see your file copying 

onto the ftp site.  Copying may take several minutes.  When it is done, 

you will see your file on the site.  Then close your Internet browser. 

 For the National Catalog submission, send an e-mail to 

Carolyn_Moler@nps.gov with the following information: 

 

• park name and acronym 

 

• name of tag file for new and recataloged records 

 

• list of catalog numbers in the tag file (or first and last number) 
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• request to have blue paper catalog records printed (optional) 

 

• any additional printing requests 

 

• contact name, shipping address, and phone number 

 For the CMR, send an e-mail to WASO_CMR_Submission@nps.gov with 

the following information: 

 

• park name and acronym 

 

• total number of research requests from within the park during the fiscal 

year 

 

• total number of research requests from outside the park during the fiscal 

year 

 

• any noteworthy accession, deaccession or other noteworthy collections 

activities during the fiscal year 

 Do not send submissions by e-mail. 

  

F. Web Catalog Transfer  

1. What is the Web Catalog 
transfer backup option? 

For parks that subscribe to the NPS web catalog, use this option to backup 

the collection directories with the data you wish to submit to the web catalog.  

It will automatically include any images attached to the catalog records. 

 

The resulting zip file will be named: 

 CR_Directory-WebCatalogTransfer-{date}.zip 

or 

 NH_Directory-WebCatalogTransfer-{date}.zip 

 For information on how to subscribe to the NPS Web Catalog, contact 

Re:discovery Software Inc. at (434) 975-3256 or support@rediscov.com.  

 
2. How do I submit only 

selected records for the 
Web Catalog? 

 

To submit only selected records to the Web Catalog: 

 

• Create a new directory to hold only those records for the Web Catalog 

(see Section III of this chapter for information on creating a new 

directory). 

 

• Create and activate a tag set of the records in your main directory that 

you want to submit to the Web Catalog.  See Section III of Chapter 7 for 

information on creating tag sets. 

 

• Select the Transfer Record(s) to Another directory option on the File � 

Transfer menu. 

 

• Select the directory you created for the Web Catalog records and choose 

All Visible Items.  Then select either Ignore duplicate record if the 

directory selected is empty, or Update the target record if the directory 

contains the same catalog records.  See Section I of Chapter 8 for more 

information on transferring records to another directory. 

 

• Click Transfer. 
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 Note:  The directory containing the Web Catalog records must have all 

records that you want to appear on the Web Catalog.  New records cannot be 

appended to existing records already appearing on the Web Catalog site. 

3. How do I run the Web 
Catalog transfer backup 
option? 

To run the Web Catalog transfer option: 

 

• In the Backup Data window, select the Web Catalog transfer backup 

option. 

 

• Select the directory you wish to backup.  Note:  You can only backup 

one directory at a time with this option.  The Web Catalog will only 

accept a single Cultural Resources directory and a single Natural History 

directory. 

 

• Select the location to save the backup file by typing a path in the location 

field or clicking Browse to select a location. 

 • You have the option to name the zip file with a different name.  To do 

this, uncheck the “Use default backup zip filename”.  Another field will 

appear below the Default backup zip filename allowing you to enter an 

alternate name.  Note:  It is recommended that you use the default 

backup zip filename so that it is easier to identify the type of backup file 

that is created. 

 

• Click Start Backup.   

 

• You will receive a warning message that this may take a long time 

without the option to cancel.  Click Yes to proceed with the backup. 

 

• Once the backup has completed, you will receive a confirmation 

message with the name and location of the zip file.  Click OK. 

 

• If you are submitting two directories (CR and NH), repeat these steps 

and select the second directory to back up. 

 

The resulting zip file will be named:   

Directory-WebCatalogTransfer-WithImages-date.zip 

4. How do I submit my Web 
Catalog data? 

There are three ways to submit your Web Catalog records after running the 

Web Catalog transfer: 

 

• Upload the file(s) to the Rediscovery ftp site, or 

 

• Send a CD with the Web Catalog transfer zip file(s) on it, or 

 

• E-mail the Web Catalog transfer zip file(s) to Rediscovery 

 

To upload the file(s) to the Rediscovery ftp site: 

 

• Use Windows Explorer or My Computer to locate your web catalog 

transfer zip file(s) created in step 3 above.  Highlight the zip file(s).  

Copy the file(s) using Ctrl-C on the keyboard; or right-click and choose 

Copy; or choose Copy from the Edit menu.  Note:  You will not see 

anything happen.  The files are copied to the Windows clipboard waiting 

to be pasted. 
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• Open your Internet browser (such as Internet Explorer).  Type the 

following address:  

 

ftp://ftp.rediscov.com/uploads 

 

• Paste your files using Ctrl-V on the keyboard; or right-click and choose 

Paste; or choose Paste from the Edit menu.  You’ll see your files 

copying onto the ftp site.  Copying may take several minutes.  When it is 

done, you will see your files on the site.  Then close your Internet 

browser. 

 To send a CD: 

 

• Write the Web catalog transfer zip file(s) to a CD using your computer’s 

CD writing software. 

 

• Mail the CD to: 

Re:discovery Software Inc. 

Attn: Web Catalog Submission 

3040 Berkmar Dr Suite B1 

Charlottesville, VA  22901 

 

Note:  With either submission option above, please send an e-mail to 

support@rediscov.com indicating that you are submitting records for the 

Web Catalog and how they are being sent (ftp or CD). 

 To e-mail the file(s) to Rediscovery: 

 

• If the transfer zip files are of a reasonable size (20 MB or less), you may 

e-mail them to Rediscovery. 

 

• Open your e-mail program and address a new message to:  

support@rediscov.com 

 

• Attach the Web Catalog transfer zip file(s) to the e-mail message before 

sending. 

5. How often can I submit 
records to the Web 
Catalog? 

The Web Catalog subscription allows two uploads per year at any time 

during the year. 

6. Where can I view the Web 
Catalog data for my park 
and other parks? 

To view the catalog data posted on the NPS Web Catalog site, in Internet 

Explorer enter the following address: 

 

http://www.museum.nps.gov 

 

The parks who have data posted are listed alphabetically. 

G. Selected Directories  

1. What is the Selected 
Directories backup option? 

This option includes all data with supplemental and associated module data 

from any directories selected. You can select multiple directories to back up 

at the same time.  They will be contained in the same zip file. 
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Note:  This option is highly recommended before you perform any mass 

modification functions such as Modify All and Global Search & Replace just 

in case you need to revert back to the original data. 

2. How do I run the Selected 
Directories backup option? 

To run the Selected Directories backup option: 

 

• In the Backup Data window, select the Selected Directories backup 

option. 

 

• Check the directory you wish to back up.  You can check as many 

directories as desired.  They will all be contained in the same zip file. 

 

• You can choose Include Images if you want to back up the images with 

the selected directories. 

 

• You can choose to Include files shared with other directories.  Note:  

This will include other directories in the backup that contain the shared 

files. 

 

• Select the location to save the backup file by typing a path in the 

location field or clicking Browse to select a location. 

 • You have the option to name the zip file with a different name.  To do 

this, uncheck the “Use default backup zip filename”.  Another field will 

appear below the Default backup zip filename allowing you to enter an 

alternate name.  Note:  It is recommended that you use the default 

backup zip filename so that it is easier to identify the type of backup file 

that is created. 

 

• Click Start Backup. 

 

• You will receive a warning message that this may take a long time 

without the option to cancel.  Click Yes to proceed with the backup. 

 

• Once the backup has completed, you will receive a confirmation 

message with the name and location of the zip file.  Click OK. 

 

The resulting zip file will be named:   

 

Directory-date.zip 
 

(Directory will be the names of the directories you selected – e.g., 

CR_PARK-NH_PARK.) 

H. Advanced SQL Database 
Management 

 

1. What is the Advanced SQL 
Database Management 
option? 

These backup options are for experienced Microsoft SQL Server database 

managers, using SQL Server 2005 Standard Edition or higher.  These options 

will allow you to create and restore backups of all or selected SQL databases 

only.  No program components are backed up with this process. 

 Do not use these backup options unless you are experienced with Microsoft 

SQL Server and are using SQL Server 2005 Standard Edition or higher. 
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2. How do I access the 
Advanced SQL Database 
Management options? 

To access the Advanced SQL Database management options, click on the 

Advanced SQL Database Management link at the bottom of the Backup Data 

window. 

 

 

3. What options are available? The following backup and restore options are available in the Advanced SQL 

Management window. 

Backup All SQL Databases This option creates a SQL backup of all databases within the program. 

Backup Selected SQL 
Databases Only 

This option allows you to select the modules and/or individual directories 

from the list below.  This creates a SQL backup of only those directory 

databases selected. 

Restore All SQL Databases If you have made a backup of all the SQL databases using the first option, 

use this option to restore those databases.  You must select the location 

where these backup files are saved. 

 

Warning:  This will overwrite the existing databases with those in the 

backup. 

Restore Selected SQL 
Databases Only 

If you have made a backup of any directory databases using the second 

backup option, select the directories you wish to restore. You must select the 

location where these backup files are saved. 

 

Warning:  This will overwrite the existing databases selected with those in 

the backup. 

Location You can select the location where to save the SQL databases by entering a 

path in the Select the Location field or clicking Browse to select the location. 

Compress Database(s)? You can choose to compress the database(s) during backup, if desired, by 

checking this box. 

 Click Start Backup or Start Restore depending on the option chosen. 
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III. CREATE NEW DIRECTORY 
 
A. Overview  

1. What is the Create New 
Directory function? 

The Create New Directory utility creates new Cultural Resources and/or 

Natural History directories in the Collections Management Module.  It also 

creates Archival/Manuscript Collections directories and optional Archives 

Item Level directories for the Archives Module. 

 

For each directory it creates, the Create New Directory function: 

 

• creates all data tables 

 

• creates associated modules 

 

• sets up all supplementals 

2. Do I need special security 
rights to create a new 
directory? 

Yes.  The Create New Directory function is security protected.  You must 

have Administrator security access to use this utility.  Refer to Section V of 

this chapter for information on security. 

3. When would I use the 
Create New Directory 
function? 

Use this function any time that you need to add a directory. 

 

4. Why would I need to add a 
directory? 

There are several reasons that you might need to add a directory.  You may: 

 

• wish to create a “working directory” for catalogers to enter and store 

catalog records until the records have been approved.  After the records 

have been approved, you can transfer them to your master database. 

 

• acquire a collection that you are going to manage separately.  You will 

then need to create a new directory (either natural history or cultural 

resources) for this new collection. 

 

• want to use an extra directory as a “holding directory” when you are 

using such functions as Import/Export, Load to Empty Directory, 

Transfer Record(s) from Disk, and Data Updates (Laptop copy).  Using 

a holding directory when you move groups of records will reduce the 

possibility of harming your master database. 

 

• take over collection management responsibility for another park’s 

museum collection.  You will then need to add directories for that park’s 

records to your system. 

B. Creating a New Directory  

1. How do I access the Create 
New Directory function? 

To access the Create New Directory function: 

 

• Go to the Tools menu. 

 

• Select Create New Directory. 
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Note:  Your login name must have the correct security rights to access the 

Create New Directory function.  If you do not have the correct security 

rights, the Create New Directory option will be grayed-out. 

 

You will see the Create New Directory screen. 

 

 

 You can also access the Create New Directory screen while performing 

several other functions that load or transfer data.  For example, there is a 

Create New Directory link on the following function windows: 

 

• Transfer Records from Disk 

 

• Load to Empty Directory 

 

• Load Data from Update Zip file (on the Data Updates menu) 

2. How do I create a new 
directory? 

Follow these steps to create a new directory: 

 

• Enter the name of the directory.  This is the name that will appear in the 

Navigation Pane. 

 

Park Collections 

Enter the four-letter park acronym in the form of “AAAA.”  If the park 

collection has a modifier, enter a collection designation in the form of a 

letter, for example, A, B, C.  Do not enter a space or symbol between the 

park acronym and the modifier. 

 

Holding or Working Directories 

Enter 3 to 5 characters.  Do not enter any spaces or symbols.  Use a 

combination of characters that will be meaningful to you.  You may 

want to use the cataloger’s name or even the words “HOLD” or 

“TEMP.” 

 Do not enter the type of collection (CR or NH) in the name.  The program 

will supply that automatically once the directory is created. 
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 • Highlight the type of directory you wish to create.  Directory types 

appear in the Directory Type box. 

 

• Click Create Directory after selecting your options.   

 

• You will be asked if you are sure you want to create the directory.  Click 

Yes to proceed with the directory creation. 

 

• A confirmation notice that the directory was created successfully 

appears.  Click OK.  The directory is now available for use. 

3. What is the Use Center 
Model Directory option? 

The Use Center Model Directory option allows you to create directories 

using center customizations that have been created for Cultural Resources 

and Natural History directory types.  To use, select either the Cultural 

Resources or Natural History directory type, check the Use Center Model 

Directory and select the Center Model Type you wish to recreate from the 

box that appears on the right.  There are 4 center models for Cultural 

Resources and 1 center model for Natural History. 

 

Note:  This option may be grayed out in your system if no center model 

directories exist to create. 
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IV.  DELETE A DIRECTORY 
 
A. Overview  

1. What is the Delete a 
Directory function? 

The Delete a Directory function removes unneeded directories from ANCS+. 

2. What kind of directories can 
I delete? 

You can delete the following types of directories: 

 

Cultural Resources 

Natural History 

Archives (4-level) 

Archives (Item) 

 When you delete a directory, you also delete all the associated modules and 

supplemental records for that directory. 

 
3. Do I need special security 

rights to delete a directory? 

 

Yes.  The Delete a Directory function is security protected.  You must have 

Administrator security rights to access this function.  Refer to Section V of 

this chapter for information on security. 

4. When would I use the 
Delete a Directory function? 

Use this function if you: 

 

• make a mistake in naming a directory and need to delete it before you 

enter any data. 

 

• make a directory to temporarily hold records being imported or 

transferred into your master directory and no longer need it 

 

• need to remove an ANCS+ directory for any reason 

B. Deleting a Directory  

1. How do I access the Delete 
a Directory function? 

To access the Delete a Directory function: 

 

• Go to the Tools menu. 

 

• Select Delete a Directory. 

 

Note:  If the Delete a Directory option is grayed out, your login name does 

not have the correct security rights to access this function. 

 

You will see the Delete Directory screen. 
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 Delete Directory Warnings: 

 

• Before you delete a directory, make sure that no users are currently 
logged into the directory.  

 

• Understand that the directory cannot be undeleted (files are not copied 
to the ‘Trash Bin’). 

 

• It is highly recommended that you allow the system to create the safety 
backup before deleting the directory. 

 
2. How do I delete a directory? 

 

Follow these steps to delete a directory: 

 

Note:  To exit the Delete a Directory screen without deleting a directory, 

click Cancel. 

 

• Select the directory that you want to delete by checking the box in front 

of the directory name.  You can select more than one directory by 

checking multiple boxes or an entire module (Be Careful!). 

 

• Select a backup location by either typing a path in the Select backup 

location field or clicking Browse to select a location to save the backup 

zip file.  It is highly recommended that you allow the system to create a 

backup of the directories that you are deleting.  However, if you do not 

want to create a backup file, check the Do not create safety backup 

option. 

 

• Click Delete Directory at the bottom right. 

 

• You will be asked if you are sure you want to delete the selected 

directories.  Click Yes to proceed with the deletion. 
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 If you choose… Then… 

 

to create a safety backup another warning appears that the backup 

process may take a long time depending on the 

amount of data in the directory.  This process 

cannot be canceled once it has begun.  Click 

Yes to proceed with the backup. 

 

 
 

Note:  You will see the backup process begin 

and a confirmation message that the backup 

was completed successfully.  Click OK to 

continue with the deletion. 

 After the safety backup is created, a final 

warning message appears giving you one last 

chance to cancel the deletion.  Click Yes to 

permanently delete the selected directories.  

Click No to cancel the deletion process. 

 

 

 If you choose… Then… 

 

not to create a safety backup a different message appears indicating your 

choice not to create the backup. 

 

 

 This is your last chance to cancel the directory deletion if you are not 

creating a safety backup.  Click Yes to permanently delete the selected 

directories without making any backup.  Click No to cancel the deletion 

process. 
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 • A confirmation message appears indicating that the directory has been 

deleted.  Click OK. 

 

 
 

Note:  The Delete Directory window will close automatically. 
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V. USER SECURITY 
 
A. Overview  

1. Does ANCS+ include a 
security system? 

Yes.  You must have a user login name (User ID) and password to use 

ANCS+.  You enter your login name and password on the Login screen to 

access ANCS+.  The system administrator can determine which users are 

allowed to add and edit catalog data, print reports, make mass changes to the 

data, delete records, use the Tools menu, and assign new users to the system.  

You can assign system-wide security rights or limit security rights to a 

particular directory. 

 

 

2. What is a User ID? Your User ID identifies you as a registered user of the ANCS+ system.  

Associate your User ID with your real name. 

 

Note:  User IDs become part of the museum record.  Your User ID is 

attached to records that you enter or modify.  It also appears in some 

supplemental records that track changes in records.  Avoid using 

inappropriate or “cute” names. 

3. What is a password? Your ANCS+ password protects your login name from use by others.  Use it 

when you enter the system.  Your password is linked to your User ID.  Keep 

your ANCS+ password secure.  Don’t share your ANCS+ password with 

others.  Do not allow other people to enter the system with your User ID and 

password.  Any changes made with your User ID are your responsibility. 

4. Where do I get a User ID 
and password? 

Your ANCS+ system administrator or whoever installs and configures your 

ANCS+ program, assigns a User ID and password to you.  The same person 

probably assigns security rights. 

5. What are user security 
rights? 

User security rights determine which: 

 

• functions and tools you can use 

 

• portions of the program you can access 

6. What do I need to assign 
User IDs, passwords, and 
security rights? 

You must have Administrator security rights to assign User IDs, passwords 

and security rights. 

7. How do I assign User IDs 
and passwords? 

The User Security option is available on the Tools menu.  Use it to assign 

User IDs, passwords, and security rights. 
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Note:  See Appendix B: Installation and Setup for information about a 

general User ID and a general password to use during installation and first-

time use. 

8. Can I print a report of all 
User IDs in my system? 

Yes.  The User Security Profile Report will print the security rights assigned 

to each User ID in the system.  See Section G below for more information. 

9. Can I view the user activity 
in my system? 

Yes.  You can view the user activity in your system by using the Manage 

User Log option on the Tools menu.  See Section H below for more 

information. 

B. User Security  

1. How do I access the User 
Security 

To access the User Security: 

 

• Choose User Security on the Tools menu, or 

 

• Select User Security under System in the Navigation Pane. 

 

You will see the list of users in the List Pane and the first user in the Record 

Pane. 

 

 

 Note:  From the User Security screen, you may add a new user, delete a user, 

or edit a user’s security profile.  If you do not have administrator rights, your 

own security profile will be the only one displayed and you will not be able 

to edit it. 

2. How do I view the security 
information for a user? 

To view the security information for a user, first select that user in the List 

Pane.  That user’s profile appears in the Record Pane. 

3. What user information is 
available on the Main 
Information tab? 

The Main Information tab contains the User ID, the Full Name of the user 

and the User Type.  It also has the link to set the password for a user. 

4. How do I go to the User 
Security Information tab? 

To move to the User Security Information tab for the current user: 

 

• Click on the User Security Information tab, or 
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• Press Ctrl-N (next) to go to the User Security Information tab. 

 

 

5. What information is 
available on the User 
Security Information tab? 

The User Security Information tab includes the General and Specific Rights 

assigned to the user.  You can also access the Advanced Module Permissions 

from this tab. 

6. What are the General Rights 
available and what do they 
allow me to do? 

General Rights are cumulative.  If you have Data Entry rights, you also have 

access to all functions available to Research.  If you have Administrator 

rights, you have access to all functions available to Data Entry and Research. 

 

General Right A user with this right can access: 
 

Administrator (Special  Automated Inventory Program 

Functions) Collections Management Report 

 Backup Data 

 Create New Directory 

 Delete a Directory 

 Import/Export 

 Data Updates (laptop copy) 

 Load to Empty Directory 

 Transfer 

 Delete Multiple Records 

 Mass Supplemental Update 

 Modify All Records 

 Global Search & Replace 

 Quick Entry 

 Pre-allocate Records 

 Reports 

 Lexicon (for editing) 

 Reclassify & Sweep Words 

 Words to Exclude from Word Search (for 

editing) 

 User Security 

 Manage User Log 

 System Options 

 Field Properties 

 Public Search Configuration 

 Table Sharing Configuration 

 Export MARC record (archives) 
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 Data Entry Add New Record 

 Copy This Record 

 Modify This Record 

 Delete This Record 

 Defaults & Carry Over Fields 

 Macros 

 Images (Import/Copy/Delete) 

 Multimedia (to edit) 

 Finding Aid/SGML (Archives) 

 Spell Check 

 Image Conversion 

 Autosave 

 Create MARC record (Archives) 

 Research Image Zoom/Print/Properties (to view) 

 Image(s) View 

 Multimedia (to view) 

 Show Images in List Pane 

 Show only Records with Images 

 Update My List View 

 Use Large Data Navigator 

 Use Hierarchical Ranges (archives) 

 View Hierarchical Browse (archives) 

 Sort 

 First/Previous/Next/Last 

 Find Record 

 Get 

 Advanced Search 

 Advanced Filter 

 Deactivate Filter 

 Tag Functions 

 Global Search Results 

 Custom Use this option to add or remove rights for 

certain functions or areas of the system.  For 

example, you may want a user to have data 

entry rights in the catalog records only plus 

access to the Reports.  This allows you to 

limit or expand a general right in certain 

areas. 

 Deaccession Administration This option allows the user to Approve 

deaccessions. 

 

All other functions in the program are available to all users with the 

exception of users who have Public Search rights only. 

 

Note:  The Administrator rights allows users the greatest flexibility.  Users 

can make mass changes to records easily.  However, the Administrator rights 

also makes it very easy for the user to make mistakes on a large scale. 
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 No user should routinely work in an ANCS+ master database with 

Administrator rights.  You can add specific rights to a user when needed 

for specific work (see below).  Delete the right when the work is completed.  

Users with Administrator rights should have a second User ID and 

password that allows them to work in the system without full security 

rights. 

 
7. What are the Specific Rights 

available and what do they 
allow me to do? 

 

Use Specific Rights to augment a general right.  For example, you may want 

to allow access to Reports and Modify All for a Data Entry user. 

 

Specific Right A user with this right can: 
 

Restricted Information add/edit/view Appraisal Supplementals 

 

Reports create/run/modify Quick Reports 

 Run/modify Rediscovery Reports 

 

Modify All access Modify All Records 

 access Global Search & Replace 

 access Mass Supplemental Update 

 

Quick Entry edit records with Quick Entry 

 

Public Search access Public Search 

 

Authority Tables add/modify/delete entries in authority tables 

 

Conservation Lab Functions currently not in use 

 

Edit Field Help edit field specific help text on Park page 

 

Change Field Labels change User field properties on Park page 

 

Lexicon add/modify/delete terms in the Lexicon 

8. What are Groups and 
Functions? 

The Groups and Functions fields are used to further define specific security 

rights for a user.  The Groups field functionality is currently not used in 

ANCS+ and should be left blank.  The Functions field is automatically filled 

in when individual Specific Rights are selected.  You cannot edit this field. 

9. What is the Advanced 
Module Permissions tab? 

The Advanced Module Permissions tab allows you to further refine a user 

profile.  You can limit access to specific modules and associated modules by 

checking the security option for each individually.   

 

For example, if you want to exclude access to your accessions information 

for a particular user, uncheck all options in the Advanced Module 

Permissions for Accessions for that user. 

 

Or, if you want to allow a user to only view Names and Addresses 

information, check the View option only for Names and Addresses in 

Advanced Module Permissions for that user. 
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 The security options are: 

 

Full Grants view, modify, add and delete rights to the selected 

module or associated module 

 

View View data and associated supplemental data with the 

exception of Appraisal Supplementals 

 

Modify All the rights of View plus the ability to modify records, 

add/modify supplemental records, add images to records. 

 

Add All the rights of Modify plus the ability to add new 

records. 

 

Delete All the rights of View plus the ability to delete a single 

record. 

C. Adding a User  

1. How do I add a new user? Follow these steps to add a new user: 

 

• Select User Security under System in the Navigation Pane. 

 

• Click the Add button  on the button bar, or 

 

• Select Add New Record from the Edit menu, or 

 

• Press F9. 

 

A new window will open for you to enter a new user.  Follow the field-by-

field instructions for completing the fields on the Main Information tab of the 

User Security record. 

 

Note:  There is no on-line screen help for these fields. 
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User ID Enter a unique user login name for the new user. 

 

User IDs can be no longer than 6 characters (alphanumeric only except the 

underscore symbol).  Do not use spaces in your User ID 

 

Parks may want to establish a system for creating User IDs, such as the 

user’s initials and numbers in a sequential order. 

 

Example: FAH123 

 RPM124 

Full Name Enter the full name of the new user. 

 

Names can be a combination of characters and numerals.  You can enter 

spaces between the parts of the name. 

 

Example: Susan R. Sarna 

 J. Edward Jones, Jr. 

User Type Enter the type of user. 

 

Enter “NPS User” for an employee of the National Park Service. 

 

Enter “Non-NPS User” for the following types: 

• an employee of a cooperating association 

• cataloging contractor 

• outside researcher 

• NPS volunteer 

Set Password Click on the Set Password link to assign the password for the user. 

 

 

 • Enter a password in the New Password field.  This is limited to 50 

alphanumeric characters or symbols.  Do not use spaces.   

 

• Then enter the same password again in the Re-enter Password field to 

confirm.   

 

• Then click Set Password. 

2. How do I assign security 
rights on the User Security 
Information tab? 

Click on the User Security Information tab or press Ctrl-N to access the page 

and assign the desired security rights for this user.  This will add the user’s 

Global security permissions. 

 

Note:  To assign specific permissions within directories, you will have to 

save the profile first, then modify it.  See Section E below.  Individual 

directories will inherit the global security rights, unless specific directory-

level security rights are assigned. 
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 Choose the General, Specific and Advanced Module Permissions (if desired) 

security rights for the new user.  Refer to sections B.5, B.6 and B.7 for a list 

of security rights and the functions available with each. 

 

Note:  If you want to use the default permissions for a general right, you only 

need to select the general right.  Specific rights and Advanced Module 

Permissions are optional. 

 

To choose a specific security right, make sure that there is a check in the box 

before the security right you wish to select.  If there is not a check in the box, 

then click on the box and one will appear. 

 

To remove a specific security right, make sure that there is not a check in the 

box before the security right you wish to remove from the user.  If there is a 

check in the box, then click on the box and the check will disappear. 

 Choose only the rights that each user needs. 

 
Groups 

 

Leave this field blank.  The Groups field is not presently used in ANCS+. 

Functions Notice that as you select specific rights, this field will be populated.  You 

cannot add to or edit this field. 

 

 

3. What is the “Use default 
permissions for selected 
general right” option? 

Click this option to restore the default permissions for the selected option 

under General Rights.  This is useful when you change the rights for a user 

so that all specific rights that may have been assigned previously are cleared 

and only the default permissions for the general right are activated. 

4. What is the Using Advanced 
Module Permissions? 

This appears if you make adjustments to the default permissions for a 

General Right on the Advanced Module Permissions tab. 

5. How do I get to the 
Advanced Module 
Permissions? 

Click on the Advance Module Permissions tab or press Ctrl-N.  Use of 

Advanced Module Permissions is optional. 

6. How do I save the new 
user? 

To save the new user record, click Save and Close at the bottom right. 



Tools/User Security 9:32 NPS ANCS+ User Manual (2006) 

 

D. Viewing, Modifying and 
Removing Users 

 

1. How do I view a list of all 
users? 

To view a list of all ANCS+ users, go to User Security.  All users are shown 

in the List Pane. 

2. How do I see the full name 
and security rights for a 
specific user? 

To see the full name and security rights for a specific user, select that user in 

the List Pane.  The user security record will load into the Record Pane.  Click 

on the various tabs in the Record Pane to view the main and user security 

information for that user. 

3. How do I change the 
security information for an 
existing user? 

To change security information for an existing user: 

 

• Select the User ID in the List Pane that you wish to edit. 

 

• Select Modify this Record from the Edit menu or press F10, or click the 

Modify button .  The record will open in a new window with Modify 

Mode indicated in the status bar at the lower right. 

 

• Make any changes desired. 

 

• Click Save and Close when finished. 

 

The system changes the security information for the user.  A system message 

tells you that the changes will take effect the next time the user logs in. 

4. How do I remove a user 
from ANCS+? 

To remove a user from ANCS+: 

 

• Select User Security under System in the Navigation Pane. 

 

• Select the user you wish to delete in the List Pane. 

 

• Select Delete This Record  under Delete Record(s) from the Edit 

menu. 

 

• The program will ask “Are sure you want to delete this record?”  Click 

Yes to delete it or No to keep it. 

5. Can I view a user’s 
password if they have 
forgotten it? 

No.  You cannot view user passwords.  If the user does not remember their 

password, you can assign a new one to them. 

 

To assign a new user password: 

 

• Select User Security under System in the Navigation Pane. 

 

• Select the user in the List Pane that needs a new password. 

 

• In the Record Pane, on the Main Information tab, click Set Password.  

Note:  You do not have to be in modify mode to change the password. 

 

• Enter a new password twice and click Set Password. 

 

• The user can now log in with the new password. 
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E. Directory Level Security  

1. Is there additional security 
available at the directory 
level? 

Yes.  You may assign security rights for specific directories. 

2. What is the purpose of 
security at the directory 
level? 

Security at the directory level provides a way to set security on a directory-

by-directory basis depending on the user’s need to work with the data.  For 

example, a user may need to add and modify records in one directory but 

only need to view the records in another directory. 

3. Should I adjust users’ rights 
for a specific directory? 

Use the directory level security only when it is absolutely necessary.  You 

must find the right balance between too much and too little security.  

Restricting users’ access too greatly places an added burden on the system 

administrator, as well as the users.  Both the system administrator and users’ 

work are interrupted when the system administrator must stop to change the 

users’ security rights. 

 

Note:  Consider giving users their own “working directory” and assigning all 

security rights to them for that directory.  When their work is accepted, it can 

be transferred into the master database.  You can then restrict full access to 

the master database.  Refer to Section III of this chapter for information on 

creating working directories.  

4. Do directory security rights 
override global security 
rights? 

Yes.  Directory security rights override global security rights.  For example, a 

user may have data entry rights at the global level but not in the natural 

history directory.  The user will be able to enter and modify data in the 

cultural resources directory but not the natural history directory. 

5. How do I create separate 
security rights for individual 
directories? 

To create directory specific security rights for a user: 

 

• Select User Security under System in the Navigation Pane. 

 

• Select the User ID in the List Pane for which you wish to create 

directory specific rights.   

 

• Modify the record by pressing F10, or clicking the modify button , or 

selecting Modify This Record on the Edit menu.  The record will open in 

Modify Mode in a separate window. 

 

• Click on the User Security Information tab. 

 

• Select the directory from the list on the left for which you wish to set up 

directory specific rights. 

 

• Once you select an individual directory, a message appears on the screen 

indicating that you must click Add to override the global security 

permissions for this directory.  Individual directories will inherit the 

global security rights unless specific directory-level security rights are 

assigned.  Click the Add link in the upper right. 

 

• Update the security rights for this directory.  The changes you make will 

only apply to the directory you selected.  See B.5, B.6 and B.7 above for 

information on the security rights options. 

 

• Click Save and Close when you have finished. 
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 The best way to limit a user to a specific directory is to first add their user 

profile to the system with the minimum rights you want them to have in all 

directories.  Then modify their profile and give them more rights in the 

directories they need to access.  For example, add a user and give them 

Research rights overall.  Then, modify their profile and add rights to their 

working directory assigning them Data Entry for that directory only. 

 
6. How can I tell in which 

directories a user has 
directory-specific rights? 

 

The directory list on the User Security Information tab shows a flag  next 

to the directories that have specific security rights assigned for that user.  All 

other directories will use the Global security rights. 

7. How do I view the directory 
specific rights? 

To view the directory-specific rights for a user: 

 

• In the User Security List Pane, select the user you wish to view. 

 

• In the Record Pane, click on the User Security Information tab. 

 

• Select the directory from the list that has a flag  next to it indicating 

that there is directory-specific security assigned. 

 

• The directory security will be displayed. 

8. How can I change the 
directory specific information 
for a user? 

To change the directory specific security for a user: 

 

• In the User Security List Pane, select the user you wish to edit. 

 

• Modify the user profile by clicking the modify button , or selecting 

Modify This Record from the Edit menu.  The record will open in a 

separate window. 

 

• Click on the User Security Information tab 

 

• Select the directory on the left for which you wish to modify the security 

rights. 

 

• Make the needed changes to the user’s directory security information. 

 

• Click Save and Close when finished. 

 

A system message tells you that the changes to the user’s security will take 

effect the next time they log in. 

9. How do I remove the 
directory-specific security for 
a user? 

To remove the directory-specific security for a user: 

 

• In the User Security List Pane, select the user you wish to edit. 

 

• Modify the user profile by clicking the modify button , or selecting 

Modify This Record from the Edit menu.  The record will open in a 

separate window. 

 

• Click on the User Security Information tab 

 

• Select the directory on the left that you wish to remove the specific 

security rights.  Only those marked with a flag  have directory 

specific security. 



 

NPS ANCS+ User Manual (2006) 9:35 Tools/User Security 

 

• Click Delete in the upper right to remove the specific rights for this 

directory.  The directory will now use the global security permissions 

assigned to the user. 

 

• Click Save and Close when finished. 

 

A system message tells you that the changes to the user’s security will take 

effect the next time they log in. 

F. Additional Questions 
About User Security 

 

1. Can I add a user to ANCS+ 
and not check any of the 
security rights boxes? 

Yes.  If you don’t check any of the security rights boxes, and leave the 

general right as custom, you limit the user to Public Search only.  Refer to 

Appendix D: Public Search, for additional information about the Public 

Search feature. 

2. Should our park keep the 
general User ID and general 
password that comes with 
ANCS+? 

Until you establish the same security rights for your ANCS+ system 

administrator, keep the: 

 

• general User ID 

 

• general password 

 

• security rights that come with the general User ID. 

 

Delete the general User ID, when the park system administrator: 

 

• is comfortable with ANCS+ security rules and procedures, and 

 

• has a User ID and password with equivalent rights in place. 

 

Note:  Every ANCS+ system is shipped with the same general User ID and 

general password. 

3. Should the system 
administrator routinely work 
in ANCS+ with full security 
rights? 

No.  Every system administrator should have two User IDs.  One User ID 

should carry system Administrator security rights and one should not.  No 

one should routinely work in the master database with Administrator rights. 

 

Log in as system administrator with administrator rights only when you need 

them. 

4. What if I lose my password 
and am unable to get into 
ANCS+? 

If you are… Then… 
 

an ANCS+ user, ask your system administrator for help. 

 

an ANCS+ system administrator, contact Re:discovery Software, Inc. for 

help.  Their telephone number is 434-

975-3256.  Their fax number is 434-

975-3935. 
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G. User Security Profile 
Report 

 

1. What is the User Security 
Profile Report? 

The User Security Profile Report lists each user with their security profile 

and what options each user’s profile contains. 

2. How do I run the User 
Security Profile Report? 

To run the report: 

 

• Select User Security under System in the Navigation Pane. 

 

• Click the User Security Profile Report button on the Button Bar 

 

 

 • A system message will ask if you want to run the report on all visible 

records.  This report will run on the currently selected user security 

profile by default, but may be run for all visible records to generate a 

complete list of ALL security profiles in the program.   

 

If you want to run the report on… Then… 

 

all visible user profiles,  click Yes 

 

the currently selected user profile, click No 

 

 

 • The resulting report may be previewed on the screen and then sent to the 

printer. 
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 • Click the printer button on the button bar or choose Print from the File 

menu. 

H. Manage User Log  

1. What is the Manage User 
Log tool? 

The program logs all access to the system. The Manage User Log feature 

allows you to manage the system-generated log of user access.  The data in 

this file can assist in identifying errors or tracking system use. 

2. How do I access the 
Manage User Log feature? 

To access the Manage User Log feature: 

 

• Select User Security under System in the Navigation Pane. 

 

• On the Tools menu, select Manage User Log.  The Manage User Log 

window will open. 

 

 

 • Click View user log data at the bottom to load the records into the 

window. 
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3. What information is 
available in the User Log? 

The Manage User Log window: 

 

• indicates the number of records contained in the user log 

 

• shows the date of the oldest entry 

 

• lists the User ID of each person who logged into the system 

 

• allows you to view a history of each user’s login date/time and logout 

date/time.  Note:  The records are initially arranged in chronological 

order by the Login Time – oldest to newest. 

 

You can sort by a different column by clicking on the column header.  For 

example, to sort the list by User ID, click on the User column header. 

 

You can also use quick filter on the User column.  Hover over the column 

header and click the small down arrow that appears in the upper right corner 

of the header.  Select the User name to filter for.  To clear the quick filter, 

click the small down arrow on the column header again and choose All.  (See 

Section II of Chapter 7 for information on using Quick Filters.) 

4. What is the Purge function? The purge function clears the user log of outdated records. 

5. Why would I want to purge 
the user log? 

Although the user log file is small, you may need to reduce it from time to 

time, especially on heavily accessed multi-user systems. 

6. How do I purge the user 
log? 

To purge the user log: 

 

• Specify a date to use for purging the file.  Enter the date in the “Remove 

all entries…” field or click the down arrow to access a calendar and 

choose a date.   

 

• The “Save purged records” box allows you to save the purged records to 

an alternate directory.  Check this option if you wish to save the purged 

records.  Uncheck this option if you do not need to save the purged 

records. 

 

• Click Purge. 
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• A message will appear asking if you are sure you want to purge the 

records found before the specified date.  Click Yes to purge the records.  

 

• If you chose to save the purged records, a Save As window will appear 

for you to select a location to save the xml file.  The file is named “User 

Log Records(date-date).xml” with the date range of the purged records 

in the file name.  Click Save after selecting the location. 

 

• You will get a confirmation that the user log records were purged.  Click 

OK. 

 

All records prior to the date you specified will be deleted from the user log. 

7. How do I exit the Manage 
User Log window? 

To exit the Manage User Log window, click Close at the bottom right, or 

click the red X in the upper right corner. 
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VI.  SYSTEM OPTIONS 
 
A. Overview  

1. What is System Options? Use System Options to configure certain elements of the entire system and 

specific data directories. 

2. Do I need special security 
rights to use System 
Options? 

Yes.  System Options is available only to users with Administrator rights.  

See Section V of this chapter for information on User Security. 

3. When would I use System 
Options? 

Use System Options to: 

 

• set the number of records for paging limits for large data sets 

 

• tell the system which directories need to share data 

 

• name which fields you want available in your Public Search (the portion 

of the program that allows public access to selected collections data) 

 

• set the Auto Save time interval 

4. How do I access System 
Options? 

System Options is accessed from the Tools menu. 

B. System Level Options  

1. What are the system options 
on the Data Management 
tab? 

The Data Management tab includes the settings for: 

 

• Paging 

 

• Auto Save time interval 
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2. What is Paging? Some institutions have very large collections and as a result a single table in 

a directory may contain a large number of records.  The software includes a 

way to interact with Large Data Sets that differs slightly from normal 

navigation.  Certain features and navigation tools work a bit differently in 

order to optimize your use of the system.   

 

When you have a large number of records, the system can work more 

efficiently when it only has to load a certain number of records at a time, in 

pages.  Your visible data is still all records in the system, tag set, or filter, but 

the records are divided into pages and only one page of records is 

downloaded to the workstation at a time. 

 For more detailed information on Large Data Sets and Paging, see Section 

VIII of this chapter. 

 
3. What are the paging options 

I can set? 

 

You can set the following paging options: 

Maximum records to retrieve 
before paging 

This number indicates the number of records that must be in a single table 

(catalog records, for example) in a single directory before paging is activated.  

The default setting is 50,000 records.  If you have more than 50,000 catalog 

records in one directory, then paging will be activated in catalog records in 

that directory.  If you have only 1200 Accession records, paging will not be 

active there.  The maximum setting available is 50,000 records.  Depending 

on the speed of your computer and server, you may notice a slower response 

time when this number is set higher than 10,000. 

 

To change this setting, click the down arrow on the field and choose one of 

the number entries from the list. 

Default number of records per 
page when paging 

This number indicates the number of records that will load per page when 

paging is activated.  The default setting is 10,000 records per page.  If you 

have 60,000 catalog records in one directory, 10,000 records will be 

downloaded to your workstation at one time and there will be 6 pages with 

10,000 records in each page.   

 

This is similar to searching for “museum” in an on-line search engine such as 

Yahoo or Google.  The search may find millions of matches but it will 

present the results to you in pages so you can navigate through them a page 

at a time rather than making your browser load all of them at once.  The 

maximum setting available is 50,000 records.  Changes to this setting apply 

when you log into the program the next time or after getting a new group of 

records in the affected directory. 

 

To change this setting, click the down arrow on the field and choose one of 

the number entries from the list. 

Default number of records to 
retrieve when performing a Filter 
or Advanced Search 

This number indicates how many records the system loads in the Search 

Results tab when performing an Advanced Search.  When you use your 

search results, the system will load all records found into the main screen.  

For a filter, this number indicates how many records will be retrieved and 

loaded into the main screen.  The maximum setting available is 10,000 

records.   

 

Note:  This sets a default number to retrieve but you can change/override this 

setting on the Advanced Search and Advanced Filter screens.  See Section 
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VIII of this chapter for more information on using Advanced Search and 

Filter with Large Data Sets. 

 

To change this setting, click the down arrow on the field and choose one of 

the number entries from the list. 

4. What is the Auto Save time 
interval? 

Auto Save saves data as you type at a defined interval, to prevent data loss in 

the event of a power outage.  If a power outage occurs while adding or 

modifying records, your work will be saved in a temporary file.  When you 

restart the program, the system will notify you that a record was saved and 

give you options for restoring or clearing the record from memory.  See 

Section VII of this chapter for more information on Autosave records. 

5. How do I set the Auto Save 
time interval? 

On the Data Management tab in System Options, you can set the Auto Save 

interval from 0 to 600 seconds.  At 0 seconds, Auto Save is inactive.  The 

default Auto Save interval is set at 300 seconds (5 minutes) 

6. What system information is 
on the Imaging tab? 

The Imaging tab shows the location where the full images are saved within 

the program when you attach an image to a record.  

 

The default setting is: 

 

C:\Program Files\Rediscovery Software Inc\Rediscovery Version8.0\Full 

Images 

 

Note:  You cannot change this setting. 

 

 

C. Client/Workstation 
Options 

 

1. What options are available 
on the Client/Workstation 
Options tab? 

Currently, there are no options available on the Client/Workstation Options 

tab. 

D. Directory Options  

1. What options are available 
on the Directory Options 
tab? 

The Directory Options tab allows you to: 

 

• Set table sharing between directories 

 

• Select the fields that appear in the Public Search  
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2. What is Table Sharing? Table sharing lets you share specific tables between directories.  For 

example, you may want to share your user-built authority tables, accession 

file, names and addresses file, and artist file among two or more directories.  

This prevents the need for duplicate data entry in each directory.  Choose one 

directory to be the master directory, where the data will actually be stored by 

the system.  Then set table sharing for the other directories to share with the 

master directory.    

 

See Sections E-G below to set up table sharing for specific directory types. 

3. What is the Set Public 
Search Fields function? 

Use this function to define which data fields are shown in the “detail” screen 

of Public Search for a directory.  Select the specific fields and set their order 

with this function.  The next time you use Public Search, the fields you have 

chosen will appear on the Detail page. 

4. How do I set up the Public 
Search fields for a 
directory? 

For detailed information on setting Public Search fields, refer to Section II of 

Appendix D, Public Search Configuration. 

E. Table Sharing for Cultural 
Resources Directories 

 

1. How do I establish table 
sharing for my Cultural 
Resources directory? 

To set table sharing for your Cultural Resources directory: 

 

• Open System Options from the Tools menu and select the Directory 

Options tab. 

 

• Select Cultural Resources from the Directory Type list on the left 

 

• A list of your Cultural Resources directories appear on the right.  Select 

the main Cultural Resources directory for your park. 

 

• Click Update Table Sharing 
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2. How do I set duplicate 
catalog number checking for 
Cultural Resources? 

You must connect your Cultural Resources directory with your Natural 

History directory to enable the system to check for identical catalog numbers 

each time you add a new record.  To set this sharing option in the window 

above: 

 

• Check the “Catalog number uniqueness depends on another directory” 

option.  

 

• Then select your main Natural History directory in the list that appears 

below this option.    

 

The system will not allow you to save a new record with a duplicate catalog 

number. 

3. How do I connect the 
Archives directory to my 
Cultural Resources 
directory? 

To enable the system to transfer data from your Cultural Resources directory 

to your Archives directory, in the window above: 

 

• Expand the Archives module node in the Modules box on the left by 

clicking the + (if necessary). 

 

• Then click the + in front of your main archives (4-level) directory for 

your park.   

 

• Check the Collection table under the archives directory.  

 Click Save and Close after selecting your table sharing options. 

  

F. Table Sharing for Natural 
History Directories 

 

1. How do I establish table 
sharing for my Natural 
History directory? 

To set table sharing for your Natural History directory: 

 

• Open System Options from the Tools menu and select the Directory 

Options tab. 

 

• Select Natural History from the Directory Type list on the left 

 

• A list of your Natural History directories appear on the right.  Select the 

main Natural History directory for your park. 
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• Click Update Table Sharing 

 

 

2. How do I set duplicate 
catalog number checking for 
Natural History? 

To connect your Natural History directory with your main Cultural 

Resources directory for duplicate catalog number checking: 

 

• Check the “Catalog number uniqueness depends on another directory” 

option.  

 

• Then select your main Cultural Resources directory in the list that 

appears below this option.    

 

The system will not allow you to save a new record with a duplicate catalog 

number. 

3. What other tables should I 
share in the Natural History 
directory? 

You should also select the following tables from your Cultural Resources 

directory for sharing: 

 

• Expand the Collections module and then your main Cultural Resources 

directory by clicking the + in front of each in the Modules box. 

 

• Check the Accessions associated module option so that the Natural 

History records share one accession table with the Cultural Resources 

records. 

 

Note:  Sharing the Accession table automatically shares the Exhibits, Loans 

Out, Loans In, and Deaccession tables. 

 

• Check the Names and Addresses associate module so that the Natural 

History directory shares one Names and Addresses table with the 

Cultural Resources records. 

 

• You may also want to share the Artist/Maker/Eminent Figure, 

Conservation, and/or Restrictions table with the Cultural Resources 

directory.  Check these tables as desired.  

 Click Save and Close after selecting your table sharing options. 
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G. Table Sharing for Archives 
Module Directories 

 

1. How do I establish table 
sharing for my 4-level 
Archives directory? 

To set table sharing for your 4-level Archives directory: 

 

• Open System Options from the Tools menu and select the Directory 

Options tab. 

 

• Select Archives (4-level) from the Directory Type list on the left 

 

• A list of your 4-level Archives directories appear on the right.  Select the 

main Archives directory for your park. 

 

• Click Update Table Sharing 

 

 

2. How do I connect my 4-level 
Archives directory to my 
Cultural Resources 
directory? 

To connect the Archives directory to your Cultural Resources directory: 

 

• Expand the Collections module in the Modules box by clicking the + (if 

necessary) 

 

• Expand your main Cultural Resources directory 

 

• Check Catalog Records under the Cultural Resource directory.  This 

enables the system to transfer Archives information to your Cultural 

Resources records. 

 

• Check Accessions so that your Archives records share one accession 

table with the Cultural Resources directory. 

 

• Check Artist/Maker/Eminent Figure (optional). 

 

• Check Names and Addresses (optional). 

 

• Click Save and Close after selecting your table sharing options. 

3. How do I establish table 
sharing for my Item Level 
Archives directory? 

Follow the same process for the 4-level Archives directory above. 

 

Note:  The Item Level Archives directory is optional.  It provides access to 

an Item Level screen in the Archives Module. 
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H. Other Table Sharing 
Options 

 

1. What if my park manages 
multiple collections? 

When you have finished setting up table sharing for all your park’s 

directories, repeat this process for any other parks or collections in your 

system.  Follow the steps outlined in E-G above. 

2. Can I share user-built 
authority tables between 
directories? 

Yes.  If you have well-established user-built authority tables in your main 

directories, you may want to share those tables with other auxiliary or 

working directories so that you don’t have to populate authority tables over 

and over again. 

 

Note:  The sharing of authority tables can only be established between the 

same directory type (e.g., cultural resources with cultural resources, natural 

history with natural history, etc.). 

3. How do I set up table 
sharing for authority tables? 

To establish table sharing for authority tables between the same directory 

type: 

 

• Open System Options from the Tools menu and select the Directory 

Options tab. 

 

• Select the Directory Type on the left. 

 

• Select the auxiliary or working directory that you want to establish 

sharing of authority tables from your master directory. 

 

• Click Update File Sharing 

 

 

 • Expand the module (Collections or Archives) that matches your selected 

directory. 

 

• Expand your master directory that is the same directory type. 

 

• Check Lookup Data.  This will make the authority tables from your main 

directory available in this working or auxiliary directory. 

 

• Click Save and Close when finished. 
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4. What other tables can I 
share between directories? 

You may wish to share other associated module tables from your master 

directory as well, such as Names and Addresses and Artist/Maker/Eminent 

Figure.  Check any desired.  The following is a list of the associated module 

tables available for sharing and the directory types that can share them. 

 

Associated Module Table Directory Where Available 

 

Accessions Cultural Resources, Natural History 

 (Note:  Accessions is not available 

independently in the Archives module 

directories, but you can set the Archives 

directory to share the Accessions table from 

a Collection directory.) 

 

Conservation Cultural Resources, Natural History 

 

Exhibits Cultural Resources, Natural History  

 (Note: Exhibits is included when you select 

Accessions)  

 

Loans Out Cultural Resources, Natural History  

 (Note:  Loans Out is included when you 

select Accessions) 

 Loans In Cultural Resources, Natural History  

 (Note:  Loans In is included when you 

select Accessions) 

 

Maintenance Cultural Resources 

 

Preparation/Treatment Natural History 

 

Deaccessions Cultural Resources, Natural History  

 (Note:  Deaccessions is included when you 

select Accessions) 

 

Restrictions All (Cultural Resources, Natural History, 

Archives) 

 (Note:  Restrictions cannot be shared 

between Collection directories and Archives 

directories) 

 

Locality Cultural Resources, Natural History 

 

Artist/Maker/Eminent Figure All (Cultural Resources, Natural History, 

Archives) 

 

Names and Addresses All (Cultural Resources, Natural History, 

Archives) 
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VII.  AUTOSAVE 
 
A. Overview  

1. What is Autosave? ANCS+ now saves your data as you work to prevent data loss in the event of 

a power outage.  If a power outage occurs while adding, copying, or 

modifying records in the software, your work will be saved in a temporary 

file. 

2. How often is my data saved 
in autosave? 

Autosave is set to save your work every 5 minutes.  This can be adjusted in 

System Options on the Tools menu.  See Section VI.B of this chapter for 

information on changing the autosave interval. 

3. How does Autosave work? As you work, autosave saves your records to a temporary file at the interval 

specified in the System Options.  When you save a record normally, the 

temporary file is cleared out.  If a power outage occurs before you save the 

record, the temporary file retains a copy of the record. 

 

These autosave records are linked to your user ID.  When you start ANCS+ 

again, the system will notify you that records were saved.  Other users will 

not see this notification when they log in unless they have records waiting in 

autosave as well. 

4. What kind of records are 
saved with autosave? 

Any records that are in modify, copy or add mode will be saved by autosave 

if a power outage occurs.  This includes all catalog and archive records and 

all associated module records. 

B. Autosave Notification  

1. What is the Autosave 
Notification? 

The Autosave notification appears when you log in to the program and have 

records in a temporary file that were not saved normally.   

 

Note:  These autosave records are linked to your User ID.  Other users will 

not see this notification if they do not have any unsaved records in autosave. 
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2. What should I do if I get this 
autosave notification? 

If you receive the Autosave Notification when you log in to the program, 

there are several actions you can take. 

 

You can choose to: 

 

• view the autosave records immediately by clicking View Now 

 

• view the autosave records later by clicking View Later 

 

• clear all the records out of autosave (for your user ID) without viewing 

or saving them by clicking Clear Autosave 

 

Note: If you do not save or clear out the autosave records at this time, this 

notification will appear each time you log in until all records are cleared or 

saved. 

3. What does the View Now 
option do? 

View Now will open the list of records saved in autosave to allow you to find 

and restore any records that have not been saved.  See Section C below for 

information on viewing autosave records. 

4. What does the View Later 
option do? 

View Later closes the Autosave Notification window allowing you to 

continue working in the program.  It saves the autosave records for you to 

view later at a more convenient time. 

5. How can I view the 
autosave records later? 

To view autosave records later, choose the Autosave option on the Tools 

menu.  Or, when you log in to the program again, the autosave notification 

will reappear for you to choose View Now. 

 

Note:  The Autosave option on the Tools menu is grayed out if no records 

are available in autosave. 

6. What does the Clear 
Autosave option do? 

Clear Autosave deletes all records in the autosave temporary file that are 

associated with your User ID.  You do not get a chance to view the records 

before deletion.   

 

You will get a message asking if you are sure you want to clear all autosave 

records.  Click Yes to clear them or No to leave them in autosave. 

C. Viewing Autosave 
Records 

 

1. How do I view the autosave 
records? 

To view the records saved by autosave: 

 

• Click the View Now option on the Autosave Notification window that 

you receive when you log in to the program, or 

 

• Select Autosave on the Tools menu. 

 

The Autosave Records window will open.  The records are listed by the 

directory and module name.  The Id will be the catalog number or unique 

identifier for the record such as the loan number or exhibit ID.  The Name 

field lists another significant identifying field for that module such as object 

name or loan description to help you identify the record. 
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2. How can I view the entire 
record? 

To view the entire record: 

 

• Highlight the record in the list you wish to view. 

 

• Click View on the bottom left.   

 

The full record will open in a new window.  The title bar on the record 

window will indicate that it is an autosave record. 

3. How do I save the autosave 
record? 

When you open an autosave record, there are several options for saving it 

depending on what mode you were in when the power outage occurred. 

 If you cancel or close the autosave record at any point without saving, it 

will be cleared from the autosave list and cannot be retrieved again. 

  

If you were in… Then… 
 

Add or Copy mode, the record will open in Modify mode and allow 

you to save it as a new record.  Click Save and 

Close to save the record. 

 

Modify mode and the autosave record will open in Modify mode 

that record was not and allow you to save it, replacing the original 

modified again later, record.  When you click Save and Close, a 

message will appear asking if you want to 

replace the original record with the one from 

autosave.  Click Yes to replace it. 

 

Modify mode and the you will get a message that a more recently 

existing record was more  modified copy of this record exists and have the 

recently edited than the  opportunity to open both records to compare 

autosave record, them. 
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 If you click… the program will… 
 

Yes, open the autosave record in Modify mode while 

the more recently modified record will open in 

View mode.  You can compare the data and 

copy information from the more recently 

modified record into the autosave record using 

copy and paste options, if desired. 

 

 Note:  You cannot copy data from the autosave 

record to the existing record since it opens in 

View Mode only and cannot be edited. 

 

No, open only the autosave record in Modify mode. 

 If you save the Autosave record at this point, you will get a message asking if 

you want to replace the more recently modified record. 

 

 

 • Click Yes to save the Autosave record replacing the more recent record. 

 

• Click No to not overwrite the more recent record.  You will be returned 

to the Autosave record which will still be in modify mode.  You can then 

Cancel the record, which will clear it from autosave. 

4. How do I delete the 
autosave record without 
saving it? 

If you do not want to save the record that is in autosave: 

 

• highlight the record in the list and click Clear at the bottom of the 

Autosave Records window, or 

 

• if you have the entire record open, click Cancel and the record will be 

removed from autosave. 

 

You will get a message asking if you are sure you want to clear the autosave 

record without saving it.  Click Yes to clear it. 

5. Can I clear all the records in 
the list at once without 
saving them? 

Yes.  If you do not want to save any records in the autosave list, click Clear 

All in the Autosave Records window.  You will get a message asking if you 

are sure you want to clear all records from autosave.  Click Yes to clear them 

all, or No to return to the list. 
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6. How do I exit from the 
Autosave Records list? 

To exit the Autosave Records window, click Close.  Any records that have 

not been cleared will remain in the list and you will get a notification the next 

time you log in. 

7. Can I view autosave records 
logged by another user? 

No.  Only the User ID that logged the autosave record can view the autosave 

records. 

D. Other Features of 
Autosave 

 

1. What happens if I modify a 
record that also has an 
autosave record waiting? 

If another user was modifying a record when a power outage occurred and 

the record was saved in autosave, you (as a different user) will not see the 

autosave notification.  Therefore, you could modify the same record before it 

is retrieved from autosave.   

 

If a user tries to modify a record that has an entry in autosave, they will get 

the following message to alert them that there is an updated version waiting 

in autosave.  The user id who has the record in autosave will be indicated.  

Only that user can save or clear the record from the autosave list. 

 

 

 • Click Yes to modify the record anyway.  When the autosave entry is 

opened later, there will be an option to compare the two records as 

described above. 

 

• Click No to cancel the modify.  You or the user who has the record in 

autosave can then restore it or clear it as necessary. 
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VIII.  LARGE DATA SETS AND PAGING 
 
A. Overview  

1. What are Large Data Sets? Some institutions have very large collections, and as a result a single table in 

a directory may contain a large number of records.  The software includes a 

way to interact with Large Data Sets that differs slightly from normal 

navigation.  Certain features and navigation tools work a bit differently in 

order to optimize your use of the system. 

2. What is Paging? When you have a large number of records, the system can work more 

efficiently when it only has to load a certain number of records at a time, in 

pages.  Your visible data is still all records in the system, Tag Set, or Filter, 

but the records are divided into pages and only one page of records is 

downloaded to the workstation at a time. 

3. How do I know if I need to 
use Paging? 

If a single table in any directory (such as catalog records) is larger than 

50,000 records, that table will use Paging. 

 50,000 is the maximum number of records the system will return before 

activating Paging. 

  

If your system seems slow to populate the List Pane and Record Pane, you 

may want to adjust the Paging limit to a lower number than 50,000, so that 

the records are downloaded and available more quickly. 

4. How will Paging affect the 
use of records in a 
directory? 

With Paging activated, the system will only download the maximum number 

of records into the List Pane as specified in the Paging settings defined in 

System Options. 

 

What this means is that if you have 65,000 catalog records in a single 

directory and the maximum number of records to retrieve before Paging is 

set at 50,000 records, Paging will be activated.  The 105,000 records will be 

divided into pages of a specified number per page.  For example, you may 

have a setting of 5,000 records per page when Paging is activated, so your 

65,000 catalog records will be divided into 13 pages of 5,000 records each. 

 

Paging is only activated for the table that exceeds the maximum records 

setting.  In the same directory as the 65,000 catalog records example above, 

if you access an associated module such as Accessions that has only 8,000 

records, Paging will not be activated for that table.  All 8,000 records will be 

downloaded to the workstation. 

 

You will still be able to search the entire directory regardless of how many 

records are currently downloaded. 

 This is similar to searching for “museum” in an on-line search engine 

such as Yahoo or Google.  The search may find millions of matches but it 

will present the results to you in pages so you can navigate through them a 

page at a time rather than making your browser load all of them at once. 

 
5. Can I set how many records 

are downloaded per page? 

 

Yes.  The user can control some Paging settings such as how many records 

must be in a database before Paging is activated and how many records are 

loaded into each page.  These settings appear in System Options on the Tools 

menu and are located on the Data Management Tab under System Level 

Options.  These settings are system wide and will apply to all workstations. 
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6. What features are affected 
by Paging? 

The features that work a bit differently when Paging is activated are: 

 

• Get 

• Quick Search 

• Quick Filter 

• Quick Sort 

• Advanced Search 

• Advanced Filter 

• Print List and Preview List 

• Export List 

• Grouping 

• My List View 

 

Refer to the sections below for information on how these features work when 

Paging is activated. 

B. Large Data Set and Paging 
Settings 

 

1. How do I change the Large 
Data Set and Paging 
settings? 

To change the Large Data Set and Paging settings: 

 

Select System Options on the Tools menu.  (Note:  You must have 

Administrator rights to access System Options.) 

 

The Paging settings are on the Data Management tab of the System Level 

Options page. 

 

 

2. How do I set the maximum 
number of records before 
Paging is activated? 

The system default setting for the maximum number of records in a directory 

before Paging is activated is 50,000.  This is also the maximum setting 

available.  Depending on the speed of your computer and server, you may 

notice a slower response time when this number is set higher than 10,000. 

 

To change this setting to a lower number in the Systems Options window, 

click the down arrow on the “Maximum records to retrieve before Paging”  

field.  Changes to this setting apply when you log into the program the next 

time or after getting a new group of records in the affected directory.  Your 

choices are: 

 

• 500 

• 1000 
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• 2000 

• 5000 

• 10000 

• 20000 

• 50000 

 

Using the setting of 10,000, for example, if you have more than 10,000 

catalog records in one directory, then Paging will be activated in Catalog 

records in that directory.  If you have only 8,000 accession records, Paging 

will not be active there. 

3. What is the “Default number 
of records per page when 
Paging” setting? 

The “Default number of records per page when paging” number indicates the 

number of records that will load per page when Paging is activated.  The 

system default is set at 10,000 records per page. 

 

To change this setting to another number in the Systems Options window, 

click the down arrow on the field.  Your choices are: 

 

• 100 

• 200 

• 500 

• 1000 

• 2000 

• 5000 

• 10000 

• 20000 

• 50000 

 

Using the a setting of 2000 records per page, for example, if you have 66,000 

catalog records in one directory, only 2000 records will be downloaded to 

your workstation at one time and there will be 33 pages of 2000 records in 

each page.  

4. What is the setting for 
records to return when using 
Filter or Advanced Search? 

The “Default number of records to retrieve when performing a Filter or 

Advanced Search” number indicates how many records the system loads in 

the Search Results tab when performing an Advanced Search.  When you use 

your search results, the system will load all records found into the main 

screen.  For a Filter, this number indicates how many records will be 

retrieved and loaded into the main screen.  The maximum setting available is 

10,000 records. 

 

To change this setting to a lower number in the Systems Options window, 

click the down arrow on the field.  Your choices are: 

 

• 500 

• 1000 

• 2000 

• 5000 

• 10000 

 

Note:  This sets a default number to retrieve but you can change/override this 

setting on the Advanced Search and Advanced Filter screens.  See sections D 

and E below for more details on using Advanced Search and Filter with 

Large Data Sets. 
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C. Large Data Set Navigation  

1. How do I navigate through 
the pages when Paging is 
activated? 

A Large Data Navigator is available to the user to make viewing and 

navigating large data sets easier. 

2. Do I have to use the Large 
Data Navigator when 
Paging is activated? 

No, you do not have to use the Large Data Navigator when Paging is 

activated.  However, if the Large Data Navigator is not active, then the 

system will download only the top number of records as set in the System 

Options (2000 records in the example above) without a way to navigate to 

other records. 

 

Most of the time, using the Large Data Navigator will be the most flexible 

and efficient way to navigate large data sets.  You will still have access to 

most commonly used features, Sorts, My List View, Reports, Search, and 

Advanced Filter. 

3. When would I not want to 
use the Large Data 
Navigator? 

The best time to not use the Large Data Navigator is when you have a Tag 

Set containing fewer records than the number of records per page setting and 

you want to use Quick Sort, Quick Filter, or Grouping in the List Pane. 

4. How do I turn on the Large 
Data Navigator? 

When viewing records where Paging is activated, turn on the Large Data 

Navigator by checking the “Use Large Data Navigator” option on the View 

Menu. 

 

 

 The Large Data Navigator will appear above the List Pane and displays the 

number of records in your visible data and number of pages.  The number of 

records currently loaded still appears in lower right in the Status Bar. 

 

 

5. What does the Total Items 
number indicate in the Large 
Data Navigator? 

Total Items is the number of records in your visible data, Tag Set, or Filter.   

 

If you want to know how many records are loaded per page, look at the 

number in the status bar at the bottom of the page. 

 

Note:  If you use shift-click or control-click to select multiple records in the 

list pane, the number of records in your visible data is now the number that 

appears in the Status Bar and any action such as running reports or transfer 

will only affect those selected records. 
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6. How do I move through the 
pages of records when 
Paging is activated? 

To move from one page to another when Paging is activated: 

 

• Click Next > >  in the Large Data Navigator to move to the next page of 

records 

 

• Click < < Previous in the Large Data Navigator to move to the previous 

page of records 

7. How do I jump to a specific 
record when Paging is 
activated? 

To go to a specific record in your data based on the sort order, use the Get 

option in the Large Data Navigator as follows: 

 

• Enter what you are looking for into the field in the Large Data 

Navigator.  For example, if you are sorted by Catalog Number, enter a 

catalog number.  If you are sorted by object name, enter an object name. 

 

• Press Enter or click Get 

 

When the records are retrieved, the Paging starts over at the first record 

found and continues to the end of the data set.  The textbox will only allow 

you to do a Get on the first field of your sort.  To do a more advanced Get 

you can always use the standard Get on the toolbar. 

8. How do I return to the very 
beginning of my records? 

To return to the beginning of you records (based on the sort order), click 

Clear in the Large Data Navigator. 

9. Why do the First Record 
and Last Record functions 
not go to the very beginning 
or end of my data? 

The First Record and Last Record functions on the button bar or on the 

Record menu only apply to the current page of data. 

 

For example, if you are on page 3 of your data when Paging is activated, the 

First Record button will only take you to the top of page 3 and the Last 

Record button will only take you to the bottom of page 3 of your data. 

 

To advance to other pages, use the Large Data Navigator’s Next and 

Previous links.  Or use the Get function as described in C.7 above. 

10. Can I use Quick Sort when 
Paging is activated? 

Quick Sort works differently when Paging is activated. 

 

If the Large Data Navigator Then… 

is… 

 

Active  you cannot use Quick Sort to resort the data 

by a specific column in the List Pane. 

 

Not Active you can use Quick Sort in the List Pane, but 

it only applies the sort to the current page of 

records. 

 

This feature is best used for an active Filter or Tag Set containing fewer 

records than the “Maximum records to retrieve before Paging” setting in 

System Options. 

 

Note:  If you want to change the sort order for the entire table, you must use 

the Sorts on the button bar or under the Sort option on the Record menu. 
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11. How is My List View 
affected by Paging? 

When creating a My List View sort option, you can still select which fields to 

be displayed in the list view.  However, instead of selecting which individual 

fields to sort the records, you will need to use one of the standard sorts that 

appear in the list on the Button Bar or under the Sorts option on the Record 

Menu. 

 

 

 To select the sort option in My List View for large data sets: 

 

• Select Update My List View from the View menu. 

 

• Select the Order Results By tab 

 

• Under “When using large sets of data use this sort…”, click the down 

arrow on the field and choose the sort order you want My List View to 

use. 

 

• For Get to work in the Large Data Navigator for the My List View sort, 

you must also select the same field that the sort uses from the Column 

Pick List and add it to the Columns to Sort By.  Note:  There can be only 

one field in the Columns to Sort By list for large data sets. 

12. Can I use Grouping when 
Paging is activated? 

Grouping works differently when Paging is activated. 

 

If the Large Data Navigator Then… 

is… 

 

Active  you cannot use Grouping in the List Pane. 

 

Not Active you can use Grouping in the List Pane, but 

the grouping only applies to the current page 

of records. 

 

This feature is best used for an active Filter or Tag Set containing fewer 

records than the “Maximum records to retrieve before Paging” setting in 

System Options. 
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D. Filtering Large Data Sets  

1. Can I use Quick Filter when 
Paging is activated? 

Quick Filter works differently when Paging is activated. 

 

If the Large Data Navigator is… Then… 

 

Active  you cannot use Quick Filter to filter the 

data in the List Pane. 

 

Not Active you can use Quick Filter in the List 

Pane, but it applies the filter to the 

current page of records only. 

 

This feature is best used for an active Filter or Tag Set (small data set) 

containing fewer records than the “Maximum records to retrieve before 

Paging” setting in System Options. 

 

Note:  If you want to filter for records in the entire table, you must use the 

Advanced Filter. 

2. How do I use Advanced 
Filter with Large Data Sets 
and Paging? 

Advanced Filter  on the Button Bar or Record Menu contains 2 settings 

related to Large Data Sets and Paging. 

 

• Limit Records Returned To 

 

• Order Results By 

3. What is the Limit Records 
Returned To setting? 

The “Limit Records Returned To” setting on the Filter Criteria tab is set by 

default to the “Default number of records to retrieve when performing a 

Filter or Advanced Search” setting in System Options. 

 

 

 If the number of records found  

that match an Advanced Filter is… then… 
 

less than the “Limit Records  all of the records will be 

Returned To” setting  downloaded to the workstation 

AND  and appear in the List Pane. 

less than the “Maximum records to  The total number of records  

retrieve before Paging” setting in will appear in the Status Bar. 

System Options, 
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less than the “Limit Records  Paging will be active.  The total 

Returned To” setting  number of records found that 

AND match the Advanced Filter will 

more than the “Maximum records to  appear next to Total Items in the 

retrieve before Paging” setting in  Large Data Navigator (if active) 

System Options, as will the number of pages of  

 results. 

 more than the “Limit Records  only that number of records will 

Returned To” setting,  be downloaded to your workstation 

and appear in the List Pane.  In this 

case, not all of the records that 

matched the Advanced Filter will 

be in your visible data. 

 

more than the “Maximum records to  Paging will be active.  The total 

retrieve before Paging” setting in  number of records found that 

System Options match the Advanced Filter will 

AND  appear next to Total Items in the 

the “Limit Records Returned To” is Large Data Navigator (if active) 

set at “Greater than 10000,   as will the number of pages of 

results.  The number of records in 

the current page will appear in the 

lower right in the Status Bar. 

4. Can I change the default 
setting from the Advanced 
Filter window? 

Yes.  To change the default setting for the number of records returned, select 

an entry from the drop down menu.  Your options are: 

 

• 10 

• 20 

• 50 

• 100 

• 200 

• 500 

• 1000 

• 2000 

• 5000 

• 10000 

• Greater than 10000 

5. How do I order the results of 
a filter when using large sets 
of data? 

When you create an Advanced Filter, you have the option of choosing a field 

to sort the results by from the Advanced Filter window.  When Paging is 

activated on large data sets, instead of selecting which individual fields to 

sort the filtered records, you will need to use one of the standard sorts that 

appear in the list on the Button Bar or under the Sorts option on the Record 

Menu. 
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 To select the sort option for an Advanced Filter for large data sets: 

 

• In the Advanced Filter window, after creating your filter criteria, click 

on the Order Results By tab. 

 

• Under “When using large sets of data use this sort…”, click the down 

arrow on the field and choose the sort order you want the filter results to 

use. 

 

• For Get to work in the Large Data Navigator for the filter results sort, 

you must also select the same field that the sort uses from the Column 

Pick List and add it to the Columns to Sort By.  Note:  There can be only 

one field in the Columns to Sort By list for large data sets. 

E. Searching in Large Data 
Sets 

 

1. Can I use Quick Search with 
Large Data Sets? 

Yes.  Quick Search will search for the term you enter in all records in your 

data including large data sets. 

2. How are the Quick Search 
results affected by large 
data sets? 

The results of a Quick Search are affected depending on the number of 

records found that contain the search term. 

 

• If the number of records found that match a Quick Search is less than the 

“Maximum records to retrieve before paging” setting in System Options, 

all of the records will be downloaded to the workstation and appear in 

the list pane.  The total number of records will appear in the lower right 

in the Status Bar.  (No Paging is activated.) 

 

• If the number of records found that match a Quick Search is more than 

the “Maximum records to retrieve before Paging” setting in System 

Options, Paging will be active.  The total number of records found that 

match a Quick Search will appear next to Total Items in the Large Data 

Navigator (if it is active) as will the number of pages of results.  The 

number of records in the current page will appear in the lower right in 

the Status Bar. 

3. How do I use Advanced 
Search with Large Data 
Sets and Paging? 

Advanced Search  on the Button Bar or Record Menu contains a Limit 

Records Returned To setting related to Large Data Sets and Paging. 
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4. What is the Limit Records 
Returned To setting in 
Advanced Search? 

Limit Records Returned To determines how many records are loaded into the 

Search Results tab of the Advanced Word Search window.  It is set by 

default to the “Default number of records to retrieve when performing a 

Filter or Advanced Search” setting in System Options. 

 

When you launch an Advanced Search, the Search Results tab will show you 

how many records found that matched the search and it will load the number 

of records in the “Limit Records Returned To” in the grid.  This shows you a 

sample of the records found that match the search. 

 

 
 

Note:  Notice above that the search found 73 records, but only 50 are 

displayed in the Search Results List.  The Limit Records Returned To was set 

at 50 in this example. 

5. Can I change the Limit 
Records Returned To 
setting? 

Yes.  To change the default setting for the number of records returned, select 

an entry from the drop down menu.  This is the number of records that will 

be loaded on the Search Results tab.  Your options are: 

 

• 10 

• 20 

• 50 

• 100 
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• 200 

• 500 

• 1000 

• 2000 

• 5000 

• 10000 

6. Can I view all records found 
in an Advanced Search if 
the results exceed the 
number in the Limit Records 
Returned to setting? 

Yes.  The Limit Records Returned To setting only affects the records loaded 

into the Search Results tab.  When you click Use Search Results after 

performing an advanced search, all records found will become your visible 

data.   

 

The Tag Set created from the search may have Paging activated depending 

on the following: 

 

• If the number of records found that match an Advanced Search is less 

than the “Maximum records to retrieve before Paging” setting in System 

Options, all of the records will be downloaded to the workstation and 

appear in the list pane.  The total number of records will appear in the 

lower right in the Status Bar. 

 

• If the number of records found that match an Advanced Search is more 

than the “Maximum records to retrieve before Paging” setting in System 

Options, Paging will be active.  The total number of records found that 

match an Advanced Search will appear next to Total Items in the Large 

Data Navigator (if it is active) as will the number of pages of results.  

The number of records in the current page will appear in the lower right 

in the Status Bar. 

F. Other Functions Affected 
by Large Data Sets 

 

1. How is the Print List and 
Preview List affected by 
Large Data Sets and 
Paging? 

Print List and Print Preview on the Button Bar and File Menu will only print 

the records as they appear in the list pane for the number of records in the 

currently viewed page.  The number of records in the page appears in the 

lower right of the Status Bar. 

 

If you want to print the list for the other pages of records, you will have to 

navigate to the additional pages using the Large Data Navigator options and 

print them separately. 

2. How are the Export List 
options affected by Large 
Data Sets and Paging? 

The Export List choices under Import/Export on the File Menu will only 

export the records as they appear in the list pane for the number of records in 

the currently viewed page.  The number of records in the page appears in the 

lower right of the Status Bar. 

 

If you want to export all the visible records, you will have to navigate to the 

additional pages using the Large Data Navigator options and export them 

separately. 

 


